
C hap te r 1

Welcome to the Civil 3D 
Environment

To paraphrase, Civil 3D isn’t your father’s AutoCAD. If you’re 

just getting into the Civil 3D environment, want to learn how to get around in models, 

and would like to understand the object styles and labels, then this is the place to start. 

Even if you’ve had a class or two, this chapter will provide a good review of some defini-

tions, terms, and techniques used throughout the book.

This chapter starts by examining the general interface of Civil 3D, the various palettes 

that are part of Civil 3D tasks, and some parts of the interface that are new to 2009 in 

general. You’ll learn how to create a new Civil 3D-based drawing in order to understand 

the way Civil 3D uses styles to display the various objects that are part of your projects. 

You’ll explore the differences between plan, isometric, and profile styles for various 

objects, and how these styles and layers work together. The chapter then discusses some 

general labeling topics, including the relationship between Civil 3D text and drawing 

scale, how styles determine label accuracy and placement, and how you can share styles 

of all sorts with the rest of your office. As a last bit, you’ll look at the help system, and 

we’ll point you to some great online resources for further exploration.

This chapter includes the following topics:

The Toolspace palettes■■

Object display styles■■

Object label styles■■

Navigating in 3D■■

Creating new Civil 3D drawings■■

Sharing styles and template creation■■
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2  ■   Chapter 1 : Welcome to the Civil 3D Environment

The Civil 3D Interface
As soon as you load Civil 3D for the first time, you’ll see some changes afoot. Unlike most 

versions of AutoCAD, Civil 3D asks you to pick a workspace right off the bat, before you 

even really know what you’re selecting. This section explores the menus and palettes that 

are unique to Civil 3D.

Civil 3D is built on AutoCAD, and there are many good texts on learning AutoCAD. Master-

ing AutoCAD 2009 by George Omura (Sybex, 2008) is a popular choice. Because this text is 

focused on learning Civil 3D, issues or customization options that are based on the AutoCAD 

technologies will generally be mentioned more in passing than in detail.

When you first launch Civil 3D, you’re presented with a question about workspaces. 

The default is Civil 3D Complete, so most users select that. It’s also where you’ll be work-

ing for most of this book.

W h at ’s a Wo r k s pac e?

Workspaces are Autodesk’s answer to having the right tool at the right time for the right  

job. Workspaces allow you to pick and choose the toolbars, menus, and palettes that make 

up your screen. By picking different combinations based on the tasks at hand, you can mini-

mize the number of toolbars on your screen, limit the number of options presented to new 

users, and spend less time in menus and more time working. Civil 3D comes with five work-

spaces right out of the box: Design, Annotation and Drafting, Survey and Topographical, 

Visualization and Rendering, and Civil 3D Complete.

When Civil 3D has finished loading (and assuming you’ve accepted the default Civil 

3D Complete workspace), it looks something like Figure 1.1. There are all kinds of new 

buttons and controls along the bottom of the drawing area—be sure to check out the 

AutoCAD Help for more information.

Here are a couple of basic definitions:

Palette set:•	  A container for palettes. In Civil 3D, this typically contains the Tool-

space, Panorama, and Tool palettes. A palette set can be turned on and off; it can 

collapse automatically when the mouse moves away, and you can make it semitrans-

parent. Palettes within Palette Sets can be toggled on and off.

Palette:•	  One tab within a palette set. Most AutoCAD users are familiar with the  

Tool palettes set, and the ability to control which palettes (such as Hatching, Render-

ing, Blocks, and so on) appear. In Civil 3D, you turn on and off the Survey and Tool-

box palettes within the Toolspace palette set by choice, and palettes will come and go 

from the Panorama palette set as needed to give you feedback.
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The Civil 3D Interface  ■   3

It’s all much more confusing to read than it is to use, so don’t worry.

Civil 3D includes a number of different palettes for handling blocks, plotting, Xrefs, 

layers, and so on. These are great tools, but first let’s examine the palette sets that make 

up the power of Civil 3D: Toolspace and Panorama.

Toolspace in Civil 3D
In Figure 1.1, the only palette set showing by default is the Toolspace. You’ll find that 

you’re in Toolspace almost constantly as you work with Civil 3D, so most users leave it 

open and docked to one side or another. If you have a second monitor, dragging it to the 

second screen is a suggested plan as well. Toolspace is where you will spend most of your 

time interacting with Civil 3D’s model and the settings that drive it. Additionally, this is 

where you’ll work with Survey information and generate reports to XML or text formats. 

Model information, drawing settings, survey, and reporting are each handled by separate 

palettes: Prospector, Settings, Survey, and Toolbox respectively. This chapter focuses on 

Prospector and Panorama because they’re part of the overall package. Chapter 4, “Sur-

vey,” deals with the Survey palette, and Chapter 2, “General Tools,” covers the Toolbox.

Figure 1.1

Civil 3D in its initial 
setup form
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4  ■   Chapter 1 : Welcome to the Civil 3D Environment

Prospector

Prospector is the main entry to the model you’ll build with Civil 3D. This is where you’ll 

dig into the various objects, work with Project Data, and create new drawings. Prospec-

tor has some major controls that we want to look at before getting deeper into individual 

model items. Because there is so much going on, let’s start at the top with a couple of but-

tons that make getting around in Prospector easier.

The first button you’ll want to know about is the preview toggle that turns on and 

off the object previews on a global level. As drawing objects are created, they generate 

previews that can be displayed in Prospector in a preview pane. This button toggles that 

pane on and off. For example, Figure 1.2 shows the different results when you select a 

parcel with the preview toggle on versus when it’s off.

As you are looking at objects in a preview window, it’s important to remember two 

things. First, previews can be toggled on and off for Prospector, as well as for the object 

branches such as Surfaces, Parcels, and so on. If you don’t see the preview when the mas-

ter toggle is on, check the object branch by right-clicking on the branch and reviewing 

the menu for Show Preview. Alignments, Surfaces, Networks, Corridors, Assemblies, 

and Subassemblies can display previews within Prospector. Second, the preview area is 

a 3D view, so you can use the ViewCube in the upper right to rotate, spin, or twist your 

perspective. (You’ll learn more about this cube in the next chapter, which discusses basic 

AutoCAD tools that help in Civil 3D modeling.)

Figure 1.2

Preview toggled off 
(left) and on (right) 

when reviewing a 
parcel. The preview 

is a 3D view.
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The Civil 3D Interface  ■   5

The second button you’ll want to familiarize yourself with is the Item View Orienta-

tion toggle. When using Toolspace as a floating-palette set, this toggles where the Civil 

3D list view of various object is oriented, at the right, or at the bottom of the palette. Fig-

ures 1.3 and 1.4 show the two options. This toggle can make large amounts of data much 

more accessible when you’re working with list view, so just remember it’s there.

The last piece of the main controls you’ll want to familiar-

ize yourself with is the drop-down menu for view selection. In 

this menu, you can select between Master View and Active Drawing View. In Master 

View, all the branches are presented, including multiple drawings if you have more than 

one open, the Projects branch, the Data Shortcuts branch, and the Drawing Templates 

branch. In Active Drawing View, you will see only the data relating to your current draw-

ing. This is handy when you’re working with a large number of drawings in general, so 

you can have them all open but focus on one drawing for the current tasks.

Figure 1.3

List view displayed at the bottom of Prospector

Figure 1.4

List view displayed at the side of Prospector

T e ac h i n g Pai n t i n g ov e r t h e Ph o n e

The exercises in this chapter might be more difficult than they should be, simply because 

you aren’t seeing the same things we are. Just to give you a fighting chance, the setup used 

for the exercises and image captures is the default Civil 3D 2009 Civil 3D Complete work-

space, displayed in a 1280×1024 window. Toolspace and Panorama will be floating, and not 

docked as we use them. We have used the resize handles on some windows to make things 

easier to read.
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6  ■   Chapter 1 : Welcome to the Civil 3D Environment

Beyond the controls, Prospector has one main pane that never goes away, and an addi-

tional pane that shows the list and preview areas when needed. This main pane resembles 

Windows Explorer’s Folder view, with plus symbols designating areas that have deeper 

objects. These symbols also allow for expansion and contraction as needed to manage the 

display of various data objects. Let’s take some time to review the buttons discussed ear-

lier, and explore the relationships between various objects.

	 1.	 Open the Exploring Prospector drawing file. (Remember, all the data for this book 

can be downloaded from www.sybex.com/go/introducingcivil3d2009.) This drawing 

shows a typical subdivision layout, with parcels and alignments defined.

	 2.	 Within Toolspace, make sure the Prospector palette is selected by clicking its tab.

	 3.	 Change the view selection to Active Drawing View to turn off the extraneous infor-

mation for now. Your Toolspace should look something like Figure 1.5.

	 4.	 Expand the Alignments branch, and then select Carson Circle by left-clicking. Note 

that no preview appears as you might expect.

	 5.	 Right-click on the Alignments branch and select Show Preview as in Figure 1.6.

	 6.	 Pick Carson Circle again and notice that the preview is now displayed at the bottom 

of the preview pane.

	 7.	 Select the Alignments branch, and note that the full collection of Alignments is now 

displayed at the bottom of the list area. If your Toolspace is too narrow, you can use 

the scroll bar to move across all of the columns.

Side/Bottom Toggle

Preview Toggle

View Drop-Down List

Main Display Area

Preview/List Area

Figure 1.5

Prospector showing the collapsed 
tree view of the Exploring Prospec-
tor drawing file. Note that some 
branches have plus signs indicating 
that they contain more subbranches.

Figure 1.6

Turning on Previews for Alignments
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The Civil 3D Interface  ■   7

	 8.	 Click the plus sign next to Sites to expand that branch, and then expand the Site 1 

branch as well.

	 9.	 Click the Parcels branch to have the parcels in the drawing listed at the bottom of the 

list area. This list is fairly long, so the short, wider window isn’t as efficient at show-

ing the data.

	10.	 Click the Side/Bottom toggle as indicated in Figure 1.5 and note that the list area 

jumps from the bottom of your palette to the side as shown in Figure 1.7.

Click and drag 
to reproportion 
window space.

Click an edge to 
resize the entire 

Toolspace.

You can also customize the columns and data displayed in the list view to make it 

more concise. Beyond the preview and list views of objects, Panorama can also be used to 

make quick edits without moving into the drawing space, navigate the drawing, or make 

easy changes to multiple items. These changes often come when you’re trying to change 

the labels on a series of Parcels, or want to change the style of all your alignments at once. 

Now you’ll work with some of the controls in the preview area to customize the data 

presented:

	 1.	 Continuing with the Exploring Prospector drawing, make sure Parcels are still 

selected, populating the list view.

	 2.	 In the List area, scroll to the right until the Perimeter column is visible.

	 3.	 Click and drag the header to rearrange the Perimeter column to the left of the Area 

column. Any time a list is presented in this view, you can drag the column headers to 

rearrange the view.

	 4.	 Once you’ve moved Perimeter, scroll a little further to the right to see the Address 

column.

Figure 1.7

List view at the side 
with the palette 
resized and repro-
portioned to make 
more data visible
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8  ■   Chapter 1 : Welcome to the Civil 3D Environment

	 5.	 Right-click on the Address column header and select Hide Column as in Figure 1.8 

to make it disappear. You can use the Hide Column option to make an individual 

column disappear, or you can move down the list that appears and uncheck columns 

as you see fit. These changes are persistent, which makes customization worth the 

seconds it takes.

	 6.	 Select the Alignments branch to display the alignments in the list view.

	 7.	 In the list view, double-click the Name field for Timber Fork, and notice that the 

name becomes editable.

	 8.	 Change the name to Claire Point and press Enter. Notice that this immediately 

updates the main Prospector pane as well.

	 9.	 In the list view or tree view, right-click the renamed Claire Point, and select Zoom 

To. The ability to zoom to almost any object using right-click menus makes project 

and model navigation very easy.

	10.	 Click the Alignments branch one more time to bring back the list view back.

	11.	 Select the first item in the list to highlight it.

	12.	 Hold down the Shift key and click the last item in the list. This will highlight all the 

items between the two selected. If you need to remove an item from this selection, 

hold down the Ctrl key as you pick individual items.

	13.	 With all the alignments highlighted, scroll to the right to find the Style column.

	14.	 Right-click the Style column header as shown in Figure 1.9 and select Edit to bring 

up the Select Style dialog.

	15.	 Select Layout from the Style drop-down list, and click OK to dismiss the dialog. Note 

the change in the arc portion of Claire Point.

The Prospector and its various views can be invaluable in working with data efficiently. 

When you’re trying to find a short alignment or zoom to the correct profile view, the 

navigation aids in Prospector can shave a few seconds off every search. The ability to 

mass-change styles and properties is available only in Prospector.

Figure 1.8

Hiding a column in 
the list view
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The Civil 3D Interface  ■   9

The two branches related to Project and Data Shortcuts that appear in the Prospector 

pane when Master View is selected are discussed in Chapter 14, “Projects.” The Draw-

ing Templates branch is merely a list of the files that are included in the default drawing 

template folder in your installation, and it can be generally ignored. For most people, the 

power of Prospector is in the Drawings area, which we’ve already covered, so let’s look at 

the Settings tab.

Settings

Although most of your time making Civil 3D really come alive will be spent using the 

settings and styles, we won’t go in to great detail in this text. The purpose here is to give 

you a basic understanding of all the things that are going on, letting you know the major 

controls, and keeping you moving forward. At a basic level, there are three items in this 

palette you should understand:

Drawing settings control the coordinate system default layer and naming conventions 

and abbreviations.

Object styles control the display of the Civil 3D model objects (such as alignments, 

profiles, surfaces, and so on) in Plan, Model, and Profile views.

Label styles control the rotation, layering, text, accuracy, and display of all object 

labels and tables.

The following sections discuss drawing settings and styles and include some exercises 

to illustrate how the changes made in this palette ripple through the drawing itself.

D r aw in  g S ettin     g s

When you first create a new blank drawing in AutoCAD or Civil 3D, you’ll find yourself 

hovering around a coordinate of 0,0. This works fine on objects and designs that have no 

dependence or tied relationship to the real world, such as a house, or a bolt, or a new car 

design, where the coordinates of the drawing simply don’t matter very much. With land 

development, however, most projects are going to be built in the real world, with real sites 

and coordinates, and location is precisely determined on both the front and back ends of 

the project.

Figure 1.9

Pick the column 
header, not the 
cells, to get the Edit 
option to appear.
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10  ■   Chapter 1 : Welcome to the Civil 3D Environment

To solve this problem, Autodesk has built coordinate systems into the Civil 3D system, 

you simply have to tell the program which coordinate system you’d like to use. Let’s take 

a quick look at this setting, and some of the other items in the Drawing Settings dialog.

	 1.	 Open the Exploring Settings drawing file.

	 2.	 Change to the Setting tab in Toolspace. Note that the same view drop-down menu 

exists as in Prospector with some different options: Active Drawings Settings View, 

Active Drawings Labels Only View, and Labels Only View. For the purpose of this 

exercise, you’ll stay in Master View.

	 3.	 Right-click the Exploring Settings file name and select Edit Drawing Settings, as 

shown in Figure 1.10, to bring up the Drawing Settings dialog.

The Units and Zone tab provides options for Units, Conversion Factors, Scale, and 

Zone. For the most part, you’ll use the Zone portion of this dialog to get your draw-

ing into a real coordinate system.

	 4.	 On the Categories drop-down list, select Honduras.

	 5.	 On the Available Coordinate Systems drop-down list, select Honduras, Norte; Meter. 

If you know the Coordinate System Code for the area you’re working in, you can 

enter it where indicated in Figure 1.11.

Enter codes here.

Figure 1.10

Accessing the Draw-
ing Settings dialog

Figure 1.11

Preparing a new 
Civil 3D drawing for 

work in La Ceiba, 
Honduras
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The Civil 3D Interface  ■   11

You’re now prepared to do survey work in La Ceiba, Honduras, should you ever get 

a job there. Beyond the coordinates, the most common changes generally relate to 

abbreviations and terminology, so you’ll fix them next.

	 6.	 Click on the Abbreviations tab. The settings here are the values that Civil 3D uses 

when it abbreviates or calls out an option in a label style.

	 7.	 Click in the Value column for the Left row and the ellipsis button will appear just to 

the right. Click the ellipsis button to open the Text Component Editor.

	 8.	 Click just to the right of the L and enter t. Then click OK to close the dialog.

	 9.	 Repeat this process for the Right row to change the value to Rt..

	10.	 Click OK to dismiss the dialog.

These simple changes will tell Civil 3D to use Lt. or Rt. anytime it abbreviates a direc-

tion, such as in an offset label. There are also options for Point of Curvature, Reverse Spi-

ral Point, and so on, which can be set however you desire. Now that you’ve modified a few 

drawing level settings, let’s explore some object settings and styles. This is where the real 

power of Civil 3D comes to light.

O b j ect   S t y les 

Working with object styles is where most people begin to see the real changes in Civil 3D 

versus other drafting or design packages. The ability to change dramatically the display of 

objects with just a few clicks really makes it easy to repurpose information. You can cre-

ate new uses for data that were previously more effort to produce than they were worth. 

Let’s look at a surface style to better understand some of the common components of an 

object style, and some of the power inherent in the applications of style.

	 1.	 Open the Exploring Object Styles drawing file. This file has a surface and a precon-

figured set of viewports that will help you understand how object styles come into 

play in various view configurations.

	 2.	 Select View ➔ Viewports ➔ Named Viewports to display the Viewports dialog.

	 3.	 Select Exploring Styles from the Named viewports list on the left. Click OK to dis-

miss the dialog, and your screen should look something like Figure 1.12.

	 4.	 On the Settings palette, expand the Surface Branch, and then expand Surface Styles.

	 5.	 Right-click Contours 2´ and 10´ (Background) and select Copy to bring up the Sur-

face Style dialog shown in Figure 1.13.

	 6.	 Click the Name field and change the name to Exhibits. Change the description to A 

style used for public meeting exhibits, and click Apply to see the changes. Note that 

the Last Modified By field now reflects your username.

	 7.	 Change to the Contours tab, and expand the Contour Smoothing option by clicking 

the plus sign next to it.
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12  ■   Chapter 1 : Welcome to the Civil 3D Environment

	 8.	 Change the Smooth Contours value to True. Remember, this is for meetings, not for 

plans, so displaying the contours is more about aesthetics than precision. Smoothing 

in a plan production situation is not generally recommended.

	 9.	 Change to the Analysis tab, and expand the Elevations options.

	10.	 Change the Scheme to Land, the Number of Ranges to 12, and the Display Type to 

3D Faces.

	11.	 Change the Elevation Display Mode to Exaggerate Elevation, and then change the 

Exaggerate Elevations by Scale Factor to 5. The Analysis dialog should now look like 

Figure 1.14.

Figure 1.12

Three views of the 
same McKinney 

Surface

Figure 1.13

The Surface Style 
dialog. The Infor-

mation, Display, 
and Summary tabs 
are common to all 

object styles.
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The Civil 3D Interface  ■   13

At this point, you’ve modified the way things will look when they’re turned on, but 

not the objects that are on and off. The Display tab is a common component to all 

object styles. It controls the display of individual components within an object, and 

how they are viewed in Civil 3D based on the viewpoint. This level of control allows 

you to have different representations of a single object in plan views and 3D (or 

Model as it’s used here) views.

	12.	 Change to the Display tab. The View Direction drop-down menu on this tab offers 

three options for a surface: Plan, Model, and Section. We like the contours as han-

dled in Plan, but let’s change what happens in 3D views.

	13.	 Select Model from the list and note that the selections in the Component display area 

change, most notably in terms of what is visible in a given view. This is indicated by 

the lightbulb icon being on or off.

	14.	 Click the bulb in the Triangles row and turn it off. Then click the bulb in the Eleva-

tions row to turn it on. The Display tab should now look like Figure 1.15.

Figure 1.14

Completed changes 
to the Elevations 
portion of the  
Analysis tab

Figure 1.15

Turning on the 
Elevations display 
in the Model View 
Direction. Make sure 
the View Direction 
is set when modify-
ing your style.
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14  ■   Chapter 1 : Welcome to the Civil 3D Environment

	15.	 Click OK to close the dialog, and you’ll see that Exhibits is now listed under your 

Surface Styles.

Building a style is all well and good, but until it’s applied, it’s hard to see any actual 

changes. Next, you’ll modify the surface to use your new style, and you’ll see the 

results of your work.

	16.	 Change to the Prospector palette, and expand the Surfaces branch under the Explor-

ing Object Styles drawing.

	17.	 Right-click McKinney and select Surface Properties to display the Surface Properties 

dialog.

	18.	 On the Information tab, select Exhibits from the Surface Styles drop-down list.

	19.	 Click OK to close the dialog. Your screen will update to reflect the new colors 

assigned as part of the Elevations analysis. Each viewport will shift some, because  

the 5X exaggeration will cause the data to be higher in the z-axis than it was.

	20.	 Click in each viewport and pan to recenter the surface in your view. When complete, 

it should look like Figure 1.16.

By using styles, you’ll be able to change the appearance of your Civil 3D model objects 

in an instant. Much as you changed the style of the Alignments in a prior section, you can 

change styles to reflect various modes and display requirements. Now, let’s discuss how 

you can label all these dynamic elements.

Figure 1.16

After assigning a 
new style, the 3D 

views have changed 
dramatically. (We 
closed Toolspace 

to make the image 
cleaner.)
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The Civil 3D Interface  ■   15

L a b el  S t y les 

Showing a surface, alignment, pipe, or any number of things in different ways is great. As 

we work through each chapter, we’ll talk about individual labeling requirements, but it’s 

important to look at some common elements here.

	 1.	 Open Exploring Label Styles. This drawing contains a surface with both spot labels 

and contour labels. You’ll use both to explore issues within the label settings.

	 2.	 Zoom in on some of the contour labels. Notice that they’re showing two decimal places. 

This is a stock style out of the box, but not many people show two decimal places in 

their contour labels.

	 3.	 In Toolspace, switch to the Settings palette, expand the Surface branch, and then 

expand Label Styles ➔ Contour.

	 4.	 Right-click Existing Major Labels and select  

Edit to display the Label Style Composer  

dialog shown in Figure 1.17.

	 5.	 Open the Layout tab.

This label is only one bit of text, but some 

labels are considerably more complicated. 

Each piece of text, line, or block is called a 

component, and appears in the drop-down 

menu near the top left of this dialog. If you 

get the task of building every label style for 

your firm, you’ll want to explore all the 

options. For the purpose of this text, you’re 

just going to change the accuracy of this 

label to something more reasonable.

	 6.	 Click the Value cell in the Contents row under the Text section. A small button will 

appear to the right with an ellipsis (…) on it.

	 7.	 Click the Ellipsis button (also referred to as the More button) to access the Text 

Component Editor dialog shown in Figure 1.18.

Figure 1.17

The Label Style 
Composer dialog is 
the same for almost 
every label you’ll 
create in Civil 3D. 
Become familiar 
with it.

Figure 1.18

The text compo-
nent editor has two 
areas: the Proper-
ties area on the left 
and an entry area 
on the right.
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16  ■   Chapter 1 : Welcome to the Civil 3D Environment

	 8.	 Click on the text in the entry area to highlight the value. The less-than and greater-

than symbols indicate values that are derived from Civil 3D model information, 

which in this case are Surface Elevation values.

	 9.	 Press the Backspace or Delete key to remove the text.

	10.	 In the Properties drop-down menu, select Surface Elevation.

	11.	 Click the Value field of the Precision row, and change the value to 1. This indicates a 

whole number will be used, with no decimal places.

	12.	 Click the blue arrow button to inject this value into the entry area at the right. Your 

dialog should look like Figure 1.19.

	13.	 Click OK to close the dialog, and note that the preview area has updated to reflect 

your changes. You may need to zoom in the preview area to see them.

	14.	 Click OK to close the Label Style Composer and update the drawing.

You’ll notice that some of the labels have updated, and some have not. This is because 

the minor contours are using a different label style than the major contours. If you 

want, you can repeat this process to update the style called Existing Minor Labels.

In the following exercise, you take a  

look at that spot label to understand how  

the Civil 3D labels react to different view  

orientations:

	 1.	 Continuing with the Exploring Label 

Styles drawing, zoom in on one of  

the surface spot labels as shown in  

Figure 1.20.

	 2.	 Select the label and then right-click  

and select Edit Label Style to display 

the Surface Spot Elevation Label Style  

dialog.

Figure 1.19

Click the blue arrow, 
or nothing will hap-

pen! This will bite 
you more often than 

you’d ever expect.

Figure 1.20

Using right-click menus will make editing much 
faster, but you have to make sure the correct 
object is selected first.
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The Civil 3D Interface  ■   17

On the dialog, to the right of the Style drop-down list is another button with a drop-

down menu. This button appears every time you have the option to select a style, and 

it gives you the ability to create a new style, copy the current style, edit the current 

style, pick from drawing, or create a child style. The idea is that you don’t have to 

stop the task at hand to dig through the full settings tree to edit or create a style; you 

can do it on the fly.

	 3.	 Click the Edit button to display the Label Style Composer. You looked at the basics of 

the layout tab earlier, so now you’ll look at the view orientation options.

	 4.	 Switch to the General tab.

	 5.	 In the preview area, click one of the rotation arrows as shown in Figure 1.21.

Click one of these 
arrows to rotate the 
view about the z-axis

	 6.	 Change the Orientation Reference dropdown list to View. Note how the labels adjust 

to reflect this change. By setting a label’s orientation reference to View, they’ll be 

placed in relation to the screen or viewport, regardless of the rotation of your view.

	 7.	 Click OK to close the dialog, and click OK to return to your drawing.

Although there is no obvious change, you can experiment with rotating your view, or 

moving to paperspace and creating viewports with various rotations. Thanks to the 

view orientation setting, the labels will update accordingly.

Before we leave the topic of labels entirely, let’s look at one last feature of Civil 3D: 

the ability of labels to scale with drawing scale.

	 8.	 Click the Annotation Scale menu and select 1˝ = 100 ,́ as shown in Figure 1.22. The 

Annotation Scale menu is located in the lower right of your screen by default.

The size of the drawing labels and text is directly related to the scale of the drawing, 

so as you work, you can assign a drawing scale, knowing that a change in the scale come 

plan time won’t mean you’ve wasted all your effort.

Figure 1.21

Rotating the  
preview drawing
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Panorama
The Panorama palette set is Civil 3D’s way of talking back to you. The palettes that 

appear on the Panorama are typically designed for special purposes such as editing pipe 

or manhole data, viewing the full array of alignment information, or warning you about 

surface building issues. Take a look at the following quick example so you’re familiar with 

the interface:

	 1.	 Open the Exploring Panorama drawing file.

	 2.	 In the drawing, select the Parker Place alignment as shown in Figure 1.23. Right-click 

and select the Edit Geometry option to display the Alignment Layout toolbar.

Figure 1.22

Changing the effec-
tive scale of a draw-
ing updates the size 

of Civil 3D labels 
across the board.

Figure 1.23

Accessing the Align-
ment Layout toolbar

73163c01.indd   18 9/2/08   5:58:08 PM



The Civil 3D Interface  ■   19

	 3.	 Within the new toolbar displayed, click the Alignment Grid View button (the third 

button from the right) to display Panorama with an Alignment Entities palette.

When Panorama is activated, various palettes will come and go as needed for the 

task at hand. When alignment is being edited, it’s one palette; when a pipe network 

is being edited, there’s one palette for pipes and another for structures. Within the 

palettes, some interface conventions hold true across the board: gray text cannot be 

edited, and columns can be turned on and off just as in the list view of Prospector.

	 4.	 Click in the Radius column for Row 2, and change the value to 250 as shown in  

Figure 1.24.

	 5.	 Right-click on the Chord Length column header, and scroll down to turn on the 

Chord Direction value. A new column will appear to the right of the Chord Length 

column, listing the relevant values.

	 6.	 Close Alignment Layout Tools by clicking the close button on the top of the palette.

There aren’t many tricks to Panorama, but remember that when it appears, it’s gener-

ally trying to tell you something important, so be sure to read the messages and informa-

tion being passed until you’re familiar with what will and won’t trigger an appearance by 

Panorama.

Getting Around in 3D
When you’re dealing with a 3D model, you should know how to get around in 3D space. 

Because many Civil 3D users come from a very flat CAD background, this section describes 

some tools and options for dealing with the model: the ViewCube that’s handy for getting 

around the model and the visual style options.

	 1.	 Open the Exploring 3D Space drawing; it contains three viewports showing the same 

surface in various representations. In the lower view of the screen is your typical Plan 

view, the top left is a 2D Wireframe view of the surface, the top right is a 3D Concep-

tual view.

	 2.	 Click in the Plan view area to activate the viewport.

Figure 1.24

Data can often be 
modified directly 
in Panorama for 
instant changes in 
the model.
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	 3.	 From the main menus, select View ➔ Visual Styles ➔ 3D Wireframe, and your screen 

should look like Figure 1.25. Note the ViewCube in the upper right of the two 3D 

styled views.

T h i n k i n g ab o u t a N e w V i d e o C ar d?

Performing this sort of work—where you display multiple view angles of the same objects, 

with different texture and display options—is a good way to stress out your video card. 

With older cards, you might get some unpredictable results. We recommend reviewing the 

Autodesk approved list if you’re thinking of upgrading. Visit www.civil3d.com\resources 

and look for the link to the Autodesk approval list.

	 4.	 Still within the Plan view, move your mouse near the ViewCube, and you’ll see vari-

ous arrows appear. Experiment with rotating the model by clicking the arrows and 

the various edges of the cube to spin the model.

	 5.	 Click an edge to rotate the model out of a Planimetric view. Notice that the style dis-

play changes to show the color banding that is part of the style.

Feel free to experiment with various visual style combinations with these objects. 

Most civil engineers and land development professionals don’t spend a lot of time work-

ing with realistic conceptual styles, but knowing what they look like and having the abil-

ity to move about in three dimensions to view your model is crucial to taking advantage 

of the full product.

Figure 1.25

One surface, three 
views. The upper 
left is still consid-
ered a 2D view by 

AutoCAD.
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Summary
Civil 3D is designed to work in a new way. The pieces from which you build your design 

are no longer lines arcs and text; they are representations of real world objects you design. 

This brings the power of dynamic modeling to the desktop, allowing you as a designer to 

experiment with multiple solutions, looking for a better solution instead of just the first 

working solution. Accessing the model through palettes such as Panorama, Prospector, 

and Settings gives you access to the design constraints and information that you’ll build 

the plans from as you work through the process. Finally, because these objects represent 

real-world items, they have length, width, and depth—which means that you need to 

understand how to view the model from every conceivable angle. Welcome to the next 

generation of land-development design.
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